Outlook 2003: Setup and Configuration
Learning Guide
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Outlook 2003: Overview

Microsoft Outlook 2003 is a powerful tool that is capable of helping you
organize large group projects and coordinate meetings among many
people. You can also use Outlook for simple, day-to-day tasks such as
managing your email or keeping track of your appointments.

Using Outlook’s... You can...

Mail Send and receive email

Contacts Create lists of addresses, phone
numbers, and email addresses

Calendar Keep track of your schedule

Tasks Organize a to-do list

Determining the Type of Your Email Account

Outlook’s Mail function is a convenient way to manage one or more email
accounts. Outlook does not give you a new email account, but it provides
organization and storage beyond what is typically offered by a web-based
email account.

Email systems come in a variety of types and Outlook can accommodate
many of them. At Tufts, you probably have one or both of the following
accounts:

Has an address that looks like...

Trumpeter email account | john.smith@tufts.edu or
jsmithO1@trumpeter-store.tufts.edu

Exchange account john.smith@ase.tufts.edu,
jsmithO1@ase.tufts.edu, or
john.smith@tufts.edu
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Configuring Outlook to Manage a Trumpter Email Account
Launching Outlook

e From the Start menu, select the All Programs submenu.

e From the All Programs submenu, select the Microsoft Office folder.
e From the Microsoft Office folder, select Microsoft Office Outlook

2003.
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@| Log OfF |§| Shut Dovwn

e The Microsoft Outlook window will appear.
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Adding a New Email Account
From the Tools menu, select E-mail Accounts.

Tools

Find

%;ﬁ Organize

[k Address Book..,  Crrl+Shift+E

| E-mail &ccounts. ., f

a0

Cuskomize. ..

Qptions. ..

»
e
il

The E-mail Accounts window will appear.
In the E-mail section, click on the option button labeled Add a new e-

mail account.

Click on the button labeled Next.

E-mail Accounts

This wizard will allow you to change the e-mail
accounts and directories that Outlook uses.

E-mail

() add a new e-mail account

() Wiew or change existing e-mail accounts

Directory

() add a new directary or address book,
() Wiew ar change existing directaries or address baaks

Next)% [ Close
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The Server Type view of the E-mail Accounts window will appear.

Click on the option button labeled IMAP.
Click on the button labeled Next.

E-mail Accounts

Server Type
‘fou can choose the bype of server vour new e-mail account will work with,

() Microsoft Exchange Server

documents.
I POP3

Connect ko a POP3 e-mail server to download wour e-mail.
(=) IMaP

folders.
(IHTTP

synchronize mailbox Falders.
() additional Server Types
Connect to another workgroup or Srd-party mail server,

Connect ko an Exchange server to read e-mail, access public folders, and share

Conneck ko an IMAP e-mail server to download e-mail and synchronize mailbos

Connect ko an HTTP e-mail server such as Hotrail ko download e-mail and

< Back ” Next>N[ Cancel
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The Internet E-mail Setting (IMAP) view of the E-mail Accounts

window will appear.

Type the following information into the appropriate boxes.

In the box labeled...
Your name

Type...
Your first and last name (for
example, John Smith)

E-mail Address

Your email address (for
example, jsmithO1@tufts.edu)

Incoming mail server (IMAP)

imap.tufts.edu

Outgoing mail server (SMTP)

smtp.tufts.edu

User Name Your Trumpeter email UTLN
(for example, jsmith01)
Password Your Trumpeter email

account password

Click on the button labeled More Settings.

E-mail Accounts @

Internet E-mail Settings (IMAP)

Logon Information

User Mame: jsmith0l

Password: e

Remember password

|:| Log on using Secure Password
Authentication (SPA)

Each of these settings are required to get waur e-mail account warking.

User Information Server Information
Your Narmne: John Smith Incoming mail server (IMAPY:  |imap, tufts.edu
E-mail Address: john. smith@turts, edu Qukgoing mail server (SMTP): smtp.bufts, edu

Maore Settings ... k

< Back H Mt = ][ Cancel
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e The Internet E-mail Settings window will appear.
e Click on the tab labeled Outgoing Server.

e Click to place a checkmark in the box labeled My outgoing server
(SMTP) requires authentication

e Confirm that the option button labeled Use same settings as my
incoming mail server is checked.

Internet E-mail Settings E|

General | Qukgoing Server |C0nnectian Advanced

My aukgoing server (SMTP) requires authentication

@ |Jse same settings as my incoming mail server

C' Log on using

(0’4 l [ Cancel
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Click on the tab labeled Advanced.
Locate the Incoming server (IMAP) section of the Server Port
Numbers area:
0 Click to place a checkmark in the box labeled This server
requires an encrypted connections (SSL.).
Locate the Outgoing sever (SMTP) section of the Server Port
Numbers area
0 Type 587 in the box labeled Outgoing Server (SMTP)
o0 Click to place a checkmark in the box labeled This server
requires an encrypted connection (SSL).
Click on the button labeled OK.

Internet E-mail Settings §|

General | Cukgoing Server || Connection Advanced

Server Port Mumbers

Incoming server (IMAPY: Q93 Use Defaults

This server requires an encrypted conneckion {5500
Cukgoing server (SMTRY: ga7|
This server requires an encrypted conneckion {350)

Server Timeouks

Shork ] Long 1 minute
Folders
Root Folder path:

(0] N[ Cancel

URNIVERSFTY



W information technology services

1S

Training

On the Internet Email Settings (IMAP) view of the E-mail Accounts

window, click on the button labeled Next.

E-mail Accounts

Internet E-mail Settings {IMAP)
Each of these settings are reguired to get wour e-mail account working,

User Information Server Information

Your Mame: Jahn Srith Incorning mail server (IMAPY: imap.tufts.edu
E-mail Address: john,smith@turts, edu Qukgoing mail server (SMTP): smtp.bufts, edu

Logon Information

User Mame: jsmithil

Remember password

|:| Log on using Secure Password More Settings ...

Authentication (SPA)

[ < Back ” Mext = h][ Cancel

]

&)

When the Congratulations view of the Email Accounts window

appears, click on the button labeled Finish.

E-mail Accounts

Congratulations!

‘ou have successfully entered all the information required to
sekup your account,

To close the wizard, click Finish,
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If you didn’t have Outlook remember your password:
The Internet E-mail window will appear.
In the box labeled Password, type your Trumpeter email

o
o

o

password.

Click on the button labeled OK to retrieve your emails.

Internet E-mail - imap.tufts.edu

‘16 v> Please enter your user name and password For the
3 Following server,

Logan
Server: | |

User Mame; |jsmitth |

Password:

[[]remember Password

[ K [}][ Caniel ]
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Configuring Outlook to Manage a Tufts Exchange Account
e If Outlook is open:
o From the File menu, select Exit.

Mew »
Open 3

Close All Ttems

Save fs..,
Save Atkachments 3
Eaolder »

Import and Expart, ..

Page Setup 3

Prink Presiew

W o

Print. .. Ckel+-P

N
™

e From the Start menu, select Control Panel.

/ Internet —) My Documents
Internet Explorar
= ; 5 My Recent Documents
.% E-mail

M ft: Cffice Cutlook
icrosoft Cifice Cutiool _S} My Pictures

.. .
Microsoft Office Word 2003 |/ My Music
i 9! My Compuker
ij Solitaire -

g My Network Places
|}_ Adobe acrobat 7.0
~ Professional

Microsaft Office Excel 2003 @ Sek Program Access and

Defaults

E—' Control Panel

S Prink dF
g Shortcut to Photoshop g Frinters and Faxes

@ A t_’.) Help and Support
/.J Search

All Programs D '2 Dell Salution Center

@l Log Off |§| Shut Down
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¢ Inthe Control Panel window that appears, double-click on the icon
labeled Mail.

Mail

The Mail Setup - Outlook window will appear.
e Click on the button labeled E-mail Accounts.

Mail Setup - Outlook |E|

E-mail Accounts

3 Setup e-mail accounts and direckories, E-miail Accounts. .

=

L

Data Files

Change settings For the files Qutlook uses to

=, - Data Files. ..
% shore e-mail messages and documents,

Profiles

Setup multiple profiles of e-mail accounts and Show Profiles
data files, Tvpically, you only need one.

Close

e The E-mail Accounts window will appear.
In the E-mail area, click on the option button labeled Add a new
email account.

e Click on the button labeled Next.

E-mail Accounts

This wizard will allow you to change the e-mail
accounts and directories that ODutlook uses.

E-mail

() add a new e-mail account

() Wiew or change existing e-mail accounts

Directory

() add a new directary or address book,

() Wiew ar change existing directaries or address baaks
/”

Mext = V\N) [ Close
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e The Server Type view of the E-mail Accounts window will appear.
e Click on the option button labeled Microsoft Exchange Server.
e Click on the button labeled Next.

E-mail Accounts g|

Server Type
‘fou can choose the bype of server vour new e-mail account will work with,

(%) Microsoft Exchange Server

Connect ko an Exchange server to read e-mail, access public folders, and share
documents.

I POP3
Connect ko a POP3 e-mail server to download wour e-mail.
) IMaP

Conneck ko an IMAP e-mail server to download e-mail and synchronize mailbos
folders.

(JHTTP

Connect ko an HTTP e-mail server such as Hotrail ko download e-mail and
synchronize mailbox Falders.

() additional Server Types
Connect to another workgroup or Srd-party mail server,

[ < Back ” Next>kj[ Cancel ]

e The Exchange Server Settings view of the E-mail Accounts window
will appear.

e Inthe box labeled Microsoft Exchange Server, type
tftmexch1.tufts.ad.tufts.edu.

e Inthe box labeled User Name, type your Tufts UTLN (for example,
jsmith01).

e Click on the button labeled Check Name.

Type the name of the mailbox set up for you by your administrator, The mailbox name
is usually vour user name.

User Marne: | jsmith01 Check Name k

e Your name will become underlined in the box labeled User Name (for
example Smith, John).

e Confirm that a checkmark appears in the box labeled Use Cached
Exchange Mode.

e Click on the button labeled Next.

information technology services
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E-mail Accounts

Exchange Server Settings
‘fou can enter the required information to connect to your Exchange server,

Type the name of your Microsoft Exchange Server computer, For information, see your
syskem administrator,

Microsoft Exchange Server: !TFTMEXCHI.tuFts.ad.tuFts.edu
Use Cached Exchange Mode

Twpe the name of the mailbox set up For you by your administrator, The mailbox name
is usually your user name,

User Marne: |Smi‘th John Check Marne

Mare Settings ...

[ < Back H Mext = N[ Cancel

e The Microsoft Office Outlook window will appear.
¢ Click on the button labeled Yes.

Microsoft Office Outlook

on your server, you must change the default delivery location using the E-mail Accounts command Fram the Tools menu. Do you wish ko continue?

o)

\y Mail From this Microsaft Exchange Server account will be delivered ko the existing Persanal Folder on your local computer, IF you wish ta keep your mail

e When the Congratulations view of the E-mail Accounts window
appears, click on the button labeled Finish.

E-mail Accounts

Congratulations!

‘ou have successfully entered all the information required to
sekup your account,

To close the wizard, click Finish,
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Adding the Tufts LDAP to Your Address Book

If you wish to be able to search the Tufts directory from your Address
Book while sending emails, you must add the Tufts LDAP directory to it.
If you do not feel comfortable or you experience problems while adding
the Tufts LDAP, please contact your FSP. To add the Tufts LDAP:

e From the Tools menu, select E-mail Accounts.

Tools |

Find 3

[t Address Book...  Crrl+Shifk+E

E-mail fccounts, .. |‘\IE

Customize. ..

Opkions. ..

AL

e The E-mail Accounts window will appear.

e Inthe Directory area, click on the option button labeled Add a new
directory or address book.

e Click on the button labeled Next.

E-mail Accounts

This wizard will allow you to change the e-mail
accounts and directories that Outlook uses.

E-mail

() add a new e-mail account

() Wiew or change existing e-mail accounts

Directory

(&) Add a new directary or address book,
~, () Wiew or change existing directories or address books

Hext = [\] [ Clase
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The Directory or Address Book Type view of the E-mail Accounts

window will appear.

Click on the option button labeled Internet Directory Service

(LDAP).
Click on the button labeled Next.

E-mail Accounts

Directory or Address Book Type
‘ou can choose the bype of directory or address book you'd like to add,

(%) Internet Directory Service {(LDAP)
Conneck ko an LDAP server ko find and verify e-mail addresses and other
infarmation.

() Additional Address Books

Connect ta an address book ta find and verify e-mail addresses and ather
information.

X

[ < Back ” Mt = [\l[ Cancel

]

The Directory Service (LDAP) Settings view of the E-mail accounts

window will appear.
In the box labeled Server Name type Idap.tufts.edu.
Click on the button labeled More Settings.

E-mail Accounts

Directory Service (LDAP) Settings
‘fou can enter the required settings ko access information in a directory service,

Server Information

Twpe the name of the directory server vour Internek service provider or system adminiskrator
has given wou.

Server Name: |Idap.tufts.edu |

Logon Information

[ This server requires me ta log on

More Setkings .. k

X

< Back H Mext = ][ Cancel
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The Add E-mail Account window will appear.
Click on the button labeled OK

Add E-mail Account

i The E-mail Account you have just added will not start until you choose Exit from the File menu, and then restart
' Microsoft Office Outlook,

The Microsoft LDAP Directory window will appear.

Microsoft LDAP Directory f$_<|

Connection | Search

Display Mame

The displaw name as it appears in the Address Book

Connection Details

Port: |389

Use Secure Sockets

Layer D
a4 ] [ Zancel Apply
16
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Click on the tab labeled Search.
In the box labeled Search base, type dc=tufts,dc=edu.
Click on the button labeled OK.

Microsoft LDAP Directory

Connectinnl Search |

Server Settings

Search timeout in seconds:

apecify the maximum number of entries wou
i
wish ko return after a successful search:

Search Options

Search base:

de=tufts,de=edu

Example:
cn=users,dc=exchange,doc=microsoft, dc=com

l Ok Nl Caniel ]

e From the Directory Service (LDAP) Settings view of the E-mail
Accounts window, click on the button labeled Next.

E-mail Accounts [Z|

Directory Service (LDAP) Settings
‘fou can enter the required settings ko access information in a directory service.

Server Information

Twpe the name of the directory server your Internet service provider or system adminiskrator
has given you,

aerver Name: |Idap.tufts.edu |

Logon Information

[ This server requires me ta log on

More Settings ...

<Back || Mext= [\ [ Cancel
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e The Congratulations view of the E-mail Accounts window will
appear.
e Click on the button labeled Finish.

E-mail Accounts

Congratulations!

‘fou have successfully entered all the information required to
setup your account,

To close the wizard, click Finish,

< Back.

Pinning Outlook to your Start menu

If you expect to use Outlook on a regular basis, you may want to

permanently add Outlook to your Start menu.

e From the Start menu, select the All Programs submenu.

e From the All Programs submenu, select the Microsoft Office
Outlook 2003 folder.
Right-click on Microsoft Office Outlook 2003.

e From the menu that appears, select Pin to Start Menu.

Microsoft Office Taols 3
@ Microsoft Office Access 2003
Microsoft Office Excel 2003

Microsoft Office Okl Open
@ Microsoft Office Pow
@ Microsoft Office Publ k

Send To 3
IE Microsoft Office War

Zuk
Copy

Create Shortcut
Delete
Rename

Sort by Mame
Properties
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You can now select Microsoft Office Outlook 2003 directly from
your Start menu.

; Internet
Internet Explorer
E-mail
Mozilla Mail

Microsoft Cffice Excel 2003

@, Set Program Access and
Defaults

‘! M5M Explorer

® Windaws Media Plaver

E Microsoft Wword

,,3 Windows Messenger

All Programs D

_-’} My Documents

5 My Recent Documents »

_9 My Pictures

J My Music

Set Program Access and
Defaulks

‘;\é Frinters and Faxes

@ Help and Suppart

19
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